Table of contents

1 General ................................................................................................................. 5
   1.1 Copyright © VIPA GmbH ................................................................. 5
   1.2 About this manual ................................................................. 6
   1.3 Safety information ................................................................. 7

2 Basics and Assembly ............................................................................................. 9
   2.1 Safety information for users .................................................... 9
   2.2 System conception ............................................................ 10
   2.3 Dimensions .............................................................................. 12
   2.4 Mounting .......................................................................... 13
   2.5 Demounting and module exchange .................................... 18
   2.6 Wiring ............................................................................... 19
   2.7 Installation guidelines ......................................................... 20
   2.8 General data ..................................................................... 23

3 Hardware description ......................................................................................... 25
   3.1 Properties ............................................................................. 25
   3.2 Structure ............................................................................. 26
       3.2.1 General ......................................................................... 26
       3.2.2 Interfaces ...................................................................... 26
       3.2.3 Memory management .................................................. 27
       3.2.4 Storage media slot ....................................................... 27
       3.2.5 Battery backup for clock and RAM .............................. 27
       3.2.6 Operating mode switch ................................................. 28
       3.2.7 Storage media slot ....................................................... 28
       3.2.8 LEDs ............................................................................. 29
   3.3 Technical data .................................................................... 30

4 Deployment ............................................................................................................ 36
   4.1 Assembly .......................................................................... 36
   4.2 Start-up behavior .............................................................. 36
   4.3 Addressing .......................................................................... 37
   4.4 Hints for the deployment of the MPI interface ...................... 38
   4.5 Hardware configuration - CPU ........................................... 39
   4.6 Hardware configuration - I/O modules .............................. 41
   4.7 Hardware configuration - Ethernet PG/OP channel ............. 41
   4.8 Setting CPU parameters .................................................. 43
       4.8.1 Parameter CPU ............................................................. 44
   4.9 Project transfer ................................................................. 46
       4.9.1 Transfer via MPI ............................................................ 46
       4.9.2 Transfer via Ethernet ..................................................... 49
       4.9.3 Transfer via MMC .......................................................... 49
   4.10 Operating modes ............................................................ 50
   4.11 Overall reset ................................................................... 52
   4.12 Firmware update ............................................................ 54
   4.13 Factory reset .................................................................. 56
   4.14 Diagnostic entries ........................................................... 56
   4.15 Using test functions for control and monitoring of variables 58
5 Configuration with TIA Portal .................................................. 60
  5.1 TIA Portal - Limitations .................................................. 60
  5.2 TIA Portal - Work environment ....................................... 60
    5.2.1 General ................................................................. 60
    5.2.2 Work environment of the TIA Portal ............................ 61
  5.3 TIA Portal - Hardware configuration - CPU .................... 62
  5.4 TIA Portal - Hardware configuration - I/O modules .......... 65
  5.5 TIA Portal - Hardware configuration - Ethernet PG/OP channel ................................................................. 66
  5.6 TIA Portal - Project transfer ......................................... 68
1 General

1.1 Copyright © VIPA GmbH

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable agreements.

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written consent of VIPA and the business management owner of the material.

For permission to reproduce or distribute, please contact: VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH Ohmstraße 4, D-91074 Herzogenaurach, Germany

Tel.: +49 9132 744 -0
Fax.: +49 9132 744-1864
EMail: info@vipa.de
http://www.vipa.com

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information.

This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

CE Conformity Declaration

Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions. Conformity is indicated by the CE marking affixed to the product.

Conformity Information

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service organization.
1.2 About this manual

Objective and contents

This manual describes the CPU 215-2BE06 of the System 200V from VIPA. It contains a description of the construction, project implementation and usage.

Target audience

The manual is targeted at users who have a background in automation technology.

Structure of the manual

The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.
Guide to the document

The following guides are available in the manual:

- An overall table of contents at the beginning of the manual
- References with page numbers

Availability

The manual is available in:

- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

Icons Headings

Important passages in the text are highlighted by following icons and headings:

- **DANGER!**
  Immediate or likely danger. Personal injury is possible.

- **CAUTION!**
  Damages to property is likely if these warnings are not heeded.

- Supplementary information and useful tips.

1.3 Safety information

Applications conforming with specifications

The system is constructed and produced for:

- communication and process control
- general control and automation tasks
- industrial applications
- operation within the environmental conditions specified in the technical data
- installation into a cubicle

- **DANGER!**
  This device is not certified for applications in
  - in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the

- project design department
- installation department
- commissioning
- operation
CAUTION!
The following conditions must be met before using or commissioning the components described in this manual:

– Hardware modifications to the process control system should only be carried out when the system has been disconnected from power!
– Installation and hardware modifications only by properly trained personnel.
– The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
2 Basics and Assembly

2.1 Safety information for users

Handling of electrostatic sensitive modules

VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges. The following symbol is attached to modules that can be destroyed by electrostatic discharges.

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment. It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception. These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable. Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load. Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

Shipping of modules

Modules must be shipped in the original packing material.

Measurements and alterations on electrostatic sensitive modules

When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:

- Floating instruments must be discharged before use.
- Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

CAUTION!
Personnel and instruments should be grounded when working on electrostatic sensitive modules.
2.2 System conception

Overview

The System 200V is a modular automation system for assembly on a 35mm profile rail. By means of the peripheral modules with 4, 8 and 16 channels this system may properly be adapted matching to your automation tasks.

Components

The System 200V consists of the following components:

- **Head modules** like CPU and bus coupler
- **Periphery modules** like I/O, function and communication modules
- **Power supplies**
- **Extension modules**

Head modules

With a head module CPU respectively bus interface and DC 24V power supply are integrated to one casing. Via the integrated power supply the CPU respectively bus interface is power supplied as well as the electronic of the connected periphery modules.

Periphery modules

The modules are direct installed on a 35mm profile rail and connected to the head module by a bus connector, which was mounted on the profile rail before. The periphery modules are equipped with a 10pin respectively 18pin connector with recessed labelling. This connector provides the electrical interface for the signalling and supplies lines of the modules.
Power supplies

With the System 200V the DC 24V power supply can take place either externally or via a particularly for this developed power supply. The power supply may be mounted on the profile rail together with the System 200V modules. It has no connector to the back-plane bus.

Extension modules

The expansion modules are complementary modules providing 2- or 3wires connection facilities. The modules are not connected to the backplane bus.

Structure/dimensions

- Profile rail 35mm
- Dimensions of the basic enclosure:
  - 1 tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
  - 2 tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3
Installation

1. Head module (double width)
2. Head module (double width)
3. Periphery modules
4. Guide rails

Please note that you can only install header modules, like the CPU, the PC and couplers at slot 1 or 1 and 2 (for double width modules).

A maximum of 32 modules can be connected at the back plane bus. Take attention that here the maximum sum current of 3.5A is not exceeded. Please install modules with a high current consumption directly beside the header module.

2.3 Dimensions

Dimensions basic enclosure

- 2-tier width (HxWxD) in mm: 76 x 50.8 x 74

Installation dimensions
2.4 Mounting

General

The modules are each installed on a 35mm profile rail and connected via a bus connector. Before installing the module the bus connector is to be placed on the profile rail before.

Profile rail

For installation the following 35mm profile rails may be used:

<table>
<thead>
<tr>
<th>Order number</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-1AF00</td>
<td>35mm profile rail</td>
<td>Length 2000mm, height 15mm</td>
</tr>
<tr>
<td>290-1AF30</td>
<td>35mm profile rail</td>
<td>Length 530mm, height 15mm</td>
</tr>
</tbody>
</table>

Bus connector

System 200V modules communicate via a backplane bus connector. The backplane bus connector is isolated and available from VIPA in 1-, 2-, 4- or 8tier width. The following figure shows a 1tier connector and a 4tier connector bus:
The bus connector is to be placed on the profile rail until it clips in its place and the bus connections look out from the profile rail.

### Bus connector

<table>
<thead>
<tr>
<th>Order number</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-0AA10</td>
<td>Bus connector</td>
<td>1tier</td>
</tr>
<tr>
<td>290-0AA20</td>
<td>Bus connector</td>
<td>2tier</td>
</tr>
<tr>
<td>290-0AA40</td>
<td>Bus connector</td>
<td>4tier</td>
</tr>
<tr>
<td>290-0AA80</td>
<td>Bus connector</td>
<td>8tier</td>
</tr>
</tbody>
</table>
Installation on a profile rail

1 Head module (double width)
2 Head module (single width)
3 Periphery modules
4 Guide rails

The figure shows the installation of a 4-tier width bus connector in a profile rail and the slots for the modules. The different slots are defined by guide rails.

Assembly regarding the current consumption

- Use bus connectors as long as possible.
- Sort the modules with a high current consumption right beside the header module. In the service area of www.vipa.com a list of current consumption of every System 200V module can be found.
Please regard the allowed environmental temperatures:

1. horizontal assembly: from 0 to 60°C
2. vertical assembly: from 0 to 40°C
3. lying assembly: from 0 to 40°C

The horizontal assembly always starts at the left side with a header module, then you install the peripheral modules beside to the right. You may install up to 32 peripheral modules.

Please regard at installation!

1. Turn off the power supply before you install or remove any modules!
2. Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.

1. Head module (double width)
2. Head module (single width)
3. Periphery modules
4. Guide rails

1. Every row must be completed from left to right and it has to start with a header module.
2. Modules are to be installed side by side. Gaps are not permitted between the modules since this would interrupt the backplane bus.
3. A module is only installed properly and connected electrically when it has clicked into place with an audible click.
4. Slots after the last module may remain unoccupied.

A maximum of 32 modules can be connected at the back plane bus. Take attention that here the maximum sum current of 3.5A is not exceeded!
Mounting procedure

1. Install the profile rail. Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.

2. Press the bus connector into the profile rail until it clips securely into place and the bus-connectors look out from the profile rail. This provides the basis for the installation of your modules.

3. Start at the outer left location with the installation of your header module and install the peripheral modules to the right of this.

4. Insert the module that you are installing into the profile rail at an angle of 45 degrees from the top and rotate the module into place until it clicks into the profile rail with an audible click. The proper connection to the backplane bus can only be guaranteed when the module has properly clicked into place.

CAUTION!
Power must be turned off before modules are installed or removed!
2.5 Demounting and module exchange

Demounting

1. Remove if exists the wiring to the module, by pressing both locking lever on the connector and pulling the connector.
2. The casing of the module has a spring loaded clip at the bottom by which the module can be removed. Insert as shown, a screwdriver into the clip.
3. The clip is unlocked by pressing the screwdriver in an upward direction.
4. Pull the module.
5. Withdraw the module with a slight rotation to the top.

CAUTION!
Power must be turned off before modules are installed or removed!
Please regard that the backplane bus is interrupted at the point where the module was removed!
2.6 Wiring

Overview

Most of the periphery modules are equipped with a 10pin respectively 18pin connector. This connector provides the electrical interface for the signalling and supplies lines of the modules. Terminals with spring clamp technology are used for wiring. The spring clamp technology allows quick and easy connection of your signal and supply lines. In contrast to screw terminal connections this type of connection is vibration proof. The pin assignment of the periphery modules can be found in the description of the modules. You can use wires with a cross section of 0.08mm² up to 2.5mm² (up to 1.5mm² for 18pin connectors). The figure shows a module with a 10pole connector:

1 Locking lever
2 Pin no. at the module
3 Pin no. at the connector
4 Wiring port
5 Opening for screwdriver

The spring-clip is destroyed if you push the screwdriver into the wire port! Make sure that you only insert the screwdriver into the square hole of the connector!
Wiring procedure

1. Install the connector on the module until it locks with an audible click. For this purpose you press the two clips together as shown.
   ⇒ The connector is now in a permanent position and can easily be wired.

2. The following section shows the wiring procedure from top view. Insert a suited screwdriver at an angle into the square opening as shown.

3. Press and hold the screwdriver in the opposite direction to open the contact spring.

4. Insert the stripped end of wire into the round opening. You can use wires with a cross section of 0.08mm² up to 2.5mm² (1.5mm² for 18pin connectors).

5. By removing the screwdriver, the wire is securely fixed via the spring contact to the connector.

Wire the power supply connections first followed by the signal cables (inputs and outputs).

2.7 Installation guidelines

General

The installation guidelines contain information about the interference free deployment of a PLC system. There is the description of the ways, interference may occur in your PLC, how you can make sure the electromagnetic compatibility (EMC), and how you manage the isolation.

What does EMC mean?

Electromagnetic compatibility (EMC) means the ability of an electrical device, to function error free in an electromagnetic environment without being interfered respectively without interfering the environment.

The components of VIPA are developed for the deployment in industrial environments and meets high demands on the EMC. Nevertheless you should project an EMC planning before installing the components and take conceivable interference causes into account.
Possible interference causes

Electromagnetic interferences may interfere your control via different ways:
- Electromagnetic fields (RF coupling)
- Magnetic fields with power frequency
- Bus system
- Power supply
- Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the distance to the interference cause, interferences to your control occur by means of different coupling mechanisms.

There are:
- galvanic coupling
- capacitive coupling
- inductive coupling
- radiant coupling

Basic rules for EMC

In the most times it is enough to take care of some elementary rules to guarantee the EMC. Please regard the following basic rules when installing your PLC.

- Take care of a correct area-wide grounding of the inactive metal parts when installing your components.
  - Install a central connection between the ground and the protected earth conductor system.
  - Connect all inactive metal extensive and impedance-low.
  - Please try not to use aluminium parts. Aluminium is easily oxidizing and is therefore less suitable for grounding.

- When cabling, take care of the correct line routing.
  - Organize your cabling in line groups (high voltage, current supply, signal and data lines).
  - Always lay your high voltage lines and signal respectively data lines in separate channels or bundles.
  - Route the signal and data lines as near as possible beside ground areas (e.g. suspension bars, metal rails, tin cabinet).

- Proof the correct fixing of the lead isolation.
  - Data lines must be laid isolated.
  - Analog lines must be laid isolated. When transmitting signals with small amplitudes the one sided laying of the isolation may be favourable.
  - Lay the line isolation extensively on an isolation/protected earth conductor rail directly after the cabinet entry and fix the isolation with cable clamps.
  - Make sure that the isolation/protected earth conductor rail is connected impedance-low with the cabinet.
  - Use metallic or metallised plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.
- Consider to wire all inductivities with erase links.
- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical operating supplies when possible.
- Please take care for the targeted employment of the grounding actions. The grounding of the PLC serves for protection and functionality activity.
- Connect installation parts and cabinets with your PLC in star topology with the isolation/protected earth conductor system. So you avoid ground loops.
- If there are potential differences between installation parts and cabinets, lay sufficiently dimensioned potential compensation lines.

Isolation of conductors

Electrical, magnetically and electromagnetic interference fields are weakened by means of an isolation, one talks of absorption. Via the isolation rail, that is connected conductive with the rack, interference currents are shunt via cable isolation to the ground. Here you have to make sure, that the connection to the protected earth conductor is impedance-low, because otherwise the interference currents may appear as interference cause.

When isolating cables you have to regard the following:
- If possible, use only cables with isolation tangle.
- The hiding power of the isolation should be higher than 80%.
- Normally you should always lay the isolation of cables on both sides. Only by means of the both-sided connection of the isolation you achieve high quality interference suppression in the higher frequency area. Only as exception you may also lay the isolation one-sided. Then you only achieve the absorption of the lower frequencies. A one-sided isolation connection may be convenient, if:
  - the conduction of a potential compensating line is not possible.
  - analog signals (some mV respectively µA) are transferred.
  - foil isolations (static isolations) are used.
- With data lines always use metallic or metallised plugs for serial couplings. Fix the isolation of the data line at the plug rack. Do not lay the isolation on the PIN 1 of the plug bar!
- At stationary operation it is convenient to strip the insulated cable interruption free and lay it on the isolation/protected earth conductor line.
- To fix the isolation tangles use cable clamps out of metal. The clamps must clasp the isolation extensively and have well contact.
- Lay the isolation on an isolation rail directly after the entry of the cable in the cabinet. Lead the isolation further on to your PLC and don’t lay it on there again!

CAUTION!
Please regard at installation!

At potential differences between the grounding points, there may be a compensation current via the isolation connected at both sides.

Remedy: Potential compensation line
2.8 General data

**Reliability**
- Wiring by means of spring pressure connections (CageClamps) at the front-facing connector, core cross-section 0.08 ... 2.5mm² or 1.5 mm² (18pole plug)
- Complete isolation of the wiring when modules are exchanged
- Every module is isolated from the backplane bus

### General data

#### Conformity and approval

<table>
<thead>
<tr>
<th>Conformity</th>
<th>Approval</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE 2014/35/EU Low-voltage directive</td>
<td>UL UL 508 Approval for USA and Canada</td>
<td>RoHS 2011/65/EU Product is lead-free; Restriction of the use of certain hazardous substances in electrical and electronic equipment</td>
</tr>
<tr>
<td>2014/30/EU EMC directive</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Protection of persons and device protection

<table>
<thead>
<tr>
<th>Type of protection</th>
<th>-</th>
<th>IP20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical isolation</td>
<td>-</td>
<td>electrially isolated</td>
</tr>
<tr>
<td>to the field bus</td>
<td>-</td>
<td>electrially isolated</td>
</tr>
<tr>
<td>to the process level</td>
<td>-</td>
<td>electrially isolated</td>
</tr>
<tr>
<td>Insulation resistance</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Insulation voltage to reference earth</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Inputs / outputs</td>
<td>-</td>
<td>AC / DC 50V, test voltage AC 500V</td>
</tr>
<tr>
<td>Protective measures</td>
<td>-</td>
<td>against short circuit</td>
</tr>
</tbody>
</table>

#### Environmental conditions to EN 61131-2

**Climatic**
- **Storage / transport**: EN 60068-2-14 -25…+70°C
- **Operation**
  - **Horizontal installation hanging**: EN 61131-2 0…+60°C
  - **Horizontal installation lying**: EN 61131-2 0…+40°C
  - **Vertical installation**: EN 61131-2 0…+40°C
  - **Air humidity**: EN 60068-2-30 RH1 (without condensation, rel. humidity 10…95%)
  - **Pollution**: EN 61131-2 Degree of pollution 2
Environmental conditions to EN 61131-2

<table>
<thead>
<tr>
<th>Installation altitude max.</th>
<th>2000m</th>
</tr>
</thead>
</table>

Mechanical

<table>
<thead>
<tr>
<th>Oscillation</th>
<th>EN 60068-2-6</th>
<th>1g, 9Hz ... 150Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shock</td>
<td>EN 60068-2-27</td>
<td>15g, 11ms</td>
</tr>
</tbody>
</table>

Mounting conditions

<table>
<thead>
<tr>
<th>Mounting place</th>
<th>In the control cabinet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting position</td>
<td>Horizontal hanging, lying horizontally and vertical</td>
</tr>
</tbody>
</table>

EMC

<table>
<thead>
<tr>
<th>Standard</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 61000-6-4</td>
<td>Class A (Industrial area)</td>
</tr>
<tr>
<td>EN 61000-6-2</td>
<td>Industrial area</td>
</tr>
<tr>
<td>EN 61000-4-2</td>
<td>ESD 8kV at air discharge (degree of severity 3), 4kV at contact discharge (degree of severity 2)</td>
</tr>
<tr>
<td>EN 61000-4-3</td>
<td>HF field immunity (casing) 80MHz … 1000MHz, 10V/m, 80% AM (1kHz) 1.4GHz … 2.0GHz, 3V/m, 80% AM (1kHz) 2GHz … 2.7GHz, 1V/m, 80% AM (1kHz)</td>
</tr>
<tr>
<td>EN 61000-4-6</td>
<td>HF conducted 150kHz … 80MHz, 10V, 80% AM (1kHz)</td>
</tr>
<tr>
<td>EN 61000-4-4</td>
<td>Burst, degree of severity 3</td>
</tr>
<tr>
<td>EN 61000-4-5</td>
<td>Surge, installation class 3 *</td>
</tr>
</tbody>
</table>

*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors for lightning and overvoltage is necessary.
3 Hardware description

3.1 Properties

CPU 215-2BE06

- Instruction set compatible with Siemens STEP®7
- Configuration by means of the Siemens SIMATIC manager
- Integrated V-Bus controller for controlling System 200V peripherals
- Integrated 24V power supply
- Total address range: 1024byte inputs, 1024byte outputs (128byte process image each)
- 128kbyte of work memory "on board"
- 192kbyte of load memory "on board"
- MMC slot (for user program)
- Battery backed clock
- MP²I interface for data transfer
- Integrated Ethernet PG/OP channel with transfer rate 10/100MBit/s
- Status LEDs for operating mode and diagnostics

Ordering data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 215PG</td>
<td>215-2BE06</td>
<td>CPU with Ethernet PG/OP channel and 128/192kbyte of work/load memory</td>
</tr>
</tbody>
</table>
3.2 Structure

3.2.1 General

**CPU 215-2BE06**

1. Operating mode switch
2. LEDs of the CPU
3. Slot for MMC memory card
4. MP²I interface
5. Slot for DC 24V power supply
6. LEDs of the Ethernet PG/OP channel
7. Ethernet interface of the Ethernet PG/OP channel

3.2.2 Interfaces

**MP²I**

1. reserved
2. M24V
3. RxD/TxD-P (line B)
4. RTS
5. M5V
6. P5V
7. P24V
8. RxD/TxD-N (line A)
9. n.c.

**RJ45**

1. Transmit +
2. Transmit -
3. Receive +
4. -
5. -
6. Receive -
7. -
8. -

**X1**

+ 1 + DC 24 V
- 2 0 V

**Power supply**

The CPU has an internal power supply. This is connected to an external supply voltage via two terminals located on the front of the unit.

- The power supply requires DC 24V. In addition to the electronic circuitry of the CPU this supply voltage is used for the modules connected to the backplane bus.
- The electronic circuitry of the CPU is not dc-insulated from the supply voltage. The power supply is protected against reverse polarity and short circuits.

*Please ensure that the polarity of the supply voltage is correct.*
**MP²I interface**
- The MPI unit provides the link for the data transfer between the CPU and the PC.
- Via bus communication you are able to exchange program and data between different CPUs that are linked over MPI.
- For a serial exchange between the partners you normally need a special MPI-converter. But now you are also able to use the VIPA "Green Cable" order number: 950-0KB00.
- This allows you to establish a serial peer-to-peer connection with VIPA system components over the MPI interface.
- Please regard the ‘Hints for the deployment of the MPI interface’ on page 38.

**Ethernet PG/OP channel**
- **8pin RJ45 jack:**
  - The RJ45 jack serves the interface to the Ethernet PG/OP channel.
  - This interface allows you to program res. remote control your CPU.
  - Configurable connections are not possible.
  - For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this.
  - ‘Hardware configuration - Ethernet PG/OP channel’ on page 41

### 3.2.3 Memory management

**Memory**
- The CPU 215-2BE06 has an integrated work memory and a load memory. The memories are battery-buffered.
  - 192kbyte load memory
  - 128kbyte work memory

### 3.2.4 Storage media slot
- As external storage medium for applications and firmware you may use a MMC storage module (Multimedia card) from VIPA (Order number: 953-0KX10).
- The VIPA storage media are pre-formatted with the PC format FAT16 and can be accessed via a card reader.
- After PowerON respectively an overall reset the CPU checks, if there is a storage medium with data valid for the CPU.
- Push the memory card into the slot until it snaps in leaded by a spring mechanism. This ensures contacting.

### 3.2.5 Battery backup for clock and RAM
- A rechargeable battery is installed on the CPU 215-2BE06 to safeguard the contents of the RAM when power is removed. This battery is also used to buffer the internal clock. The rechargeable battery is maintained by a charging circuit that receives its power from the internal power supply and that maintain the clock and RAM for a max. period of 30 days.
CAUTION!
– Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity.
– After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset, because with an empty battery the RAM content is undefined.

3.2.6 Operating mode switch

- With the operating mode switch you may switch the CPU between STOP and RUN.
- During the transition from STOP to RUN the operating mode START-UP is driven by the CPU.
- By Switching to MR (Memory Reset) you request an overall reset with following load from MMC, if a project there exists.

3.2.7 Storage media slot

- As external storage medium for applications and firmware you may use a MMC storage module (Multimedia card) from VIPA (Order number: 953-0KX10).
- The VIPA storage media are pre-formatted with the PC format FAT16 and can be accessed via a card reader.
- After PowerON respectively an overall reset the CPU checks, if there is a storage medium with data valid for the CPU.
- Push the memory card into the slot until it snaps in leaded by a spring mechanism. This ensures contacting.
3.2.8 LEDs

LEDs CPU

As soon as the CPU is supplied with 5V, the green PW-LED (Power) is on.

<table>
<thead>
<tr>
<th></th>
<th>R (RUN)</th>
<th>S (STOP)</th>
<th>SF (SFAIL)</th>
<th>FC (FRCE)</th>
<th>MC (MMC)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>yellow</td>
<td>red</td>
<td>yellow</td>
<td>yellow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

○ ○ ● X X X CPU is in STOP state.

B ○ X X X X CPU is in start-up state, the RUN LED blinks during operating OB100 at least for 3s.

● ○ ○ X X X CPU is in state RUN without error.

X X ● X X There is a system fault. More information may be found in the diagnostics buffer of the CPU.

X X X ● X Variables are forced.

X X X X B Access to the memory card.

Overall reset

○ B X X X X Overall reset is executed.

○ ● X X X X Overall reset finished.

Factory reset

● ● ○ ○ ○ ○ Factory reset is executed.

○ ● ○ ○ ○ ○ Factory reset finished without error.

Firmware update

○ ○ B B ● The alternate blinking indicates that there is new firmware on the memory card.

○ ● ● ● ● Firmware update finished without error.


on: ● | off: ○ | blinking: B | not relevant: X
In addition, the CPU has more LEDs that display the communication of the Ethernet PG/OP channel. The LEDs are located on the front of the left side of the housing.

### LEDs Ethernet PG/OP channel

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RN (RUN)</td>
<td>green</td>
<td>● Ethernet PG/OP channel is initialized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Ethernet PG/OP channel is deactivated</td>
</tr>
<tr>
<td>ST (STOP)</td>
<td>gelb</td>
<td>● Ethernet PG/OP channel is deactivated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Ethernet PG/OP channel is initialized</td>
</tr>
<tr>
<td>IF (Internal error)</td>
<td>red</td>
<td>● Ethernet PG/OP channel reports internal error</td>
</tr>
<tr>
<td>L/A (Link/Activity)</td>
<td>green</td>
<td>● Ethernet PG/OP channel is physically connected to Ethernet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ There is no physically connection to Ethernet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B Irregular flashing: Indicates communication of the Ethernet PG/OP channel via Ethernet</td>
</tr>
<tr>
<td>S (Speed)</td>
<td>green</td>
<td>● Transfer speed: 100MBit/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Transfer speed: 10MBit/s</td>
</tr>
</tbody>
</table>

### 3.3 Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>215-2BE06</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 215PG</td>
</tr>
</tbody>
</table>

**Technical data power supply**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4...28.8 V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td>✓</td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>140 mA</td>
</tr>
<tr>
<td>Current consumption (rated value)</td>
<td>1.5 A</td>
</tr>
<tr>
<td>Inrush current</td>
<td>65 A</td>
</tr>
<tr>
<td>I²t</td>
<td>0.75 A²s</td>
</tr>
<tr>
<td>Max. current drain at backplane bus</td>
<td>3 A</td>
</tr>
<tr>
<td>Max. current drain load supply</td>
<td>-</td>
</tr>
<tr>
<td>Power loss</td>
<td>6 W</td>
</tr>
</tbody>
</table>

**Load and working memory**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load memory, integrated</td>
<td>192 KB</td>
</tr>
<tr>
<td>Load memory, maximum</td>
<td>192 KB</td>
</tr>
</tbody>
</table>
### Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>215-2BE06</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work memory, integrated</td>
<td>128 KB</td>
</tr>
<tr>
<td>Work memory, maximal</td>
<td>128 KB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>-</td>
</tr>
<tr>
<td>Memory card slot</td>
<td>MMC-Card with max. 512 MB</td>
</tr>
</tbody>
</table>

#### Hardware configuration

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks, max.</td>
<td>4</td>
</tr>
<tr>
<td>Modules per rack, max.</td>
<td>total max. 32</td>
</tr>
<tr>
<td>Number of integrated DP master</td>
<td>-</td>
</tr>
<tr>
<td>Number of DP master via CP</td>
<td>8</td>
</tr>
<tr>
<td>Operable function modules</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules PtP</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules LAN</td>
<td>-</td>
</tr>
</tbody>
</table>

#### Command processing times

<table>
<thead>
<tr>
<th>Operation</th>
<th>Min. Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit instructions</td>
<td>0.18 µs</td>
</tr>
<tr>
<td>Word instruction</td>
<td>0.78 µs</td>
</tr>
<tr>
<td>Double integer arithmetic</td>
<td>1.8 µs</td>
</tr>
<tr>
<td>Floating-point arithmetic</td>
<td>40 µs</td>
</tr>
</tbody>
</table>

#### Timers/Counters and their retentive characteristics

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of S7 counters</td>
<td>256</td>
</tr>
<tr>
<td>S7 counter remanence</td>
<td>adjustable 0 up to 64</td>
</tr>
<tr>
<td>S7 counter remanence adjustable</td>
<td>C0 .. C7</td>
</tr>
<tr>
<td>Number of S7 times</td>
<td>256</td>
</tr>
<tr>
<td>S7 times remanence</td>
<td>adjustable 0 up to 128</td>
</tr>
<tr>
<td>S7 times remanence adjustable</td>
<td>not retentive</td>
</tr>
</tbody>
</table>

#### Data range and retentive characteristic

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of flags</td>
<td>8192 Bit</td>
</tr>
<tr>
<td>Bit memories retentive characteristic adjustable</td>
<td>adjustable 0 up to 256</td>
</tr>
<tr>
<td>Bit memories retentive characteristic preset</td>
<td>MB0 .. MB15</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>2047</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range DBs</td>
<td>1 ... 2047</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Max. local data size per block</td>
<td>1024 Byte</td>
</tr>
</tbody>
</table>

#### Blocks

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of OBs</td>
<td>14</td>
</tr>
</tbody>
</table>
## Hardware description

**VIPA System 200V**

### Technical data

<table>
<thead>
<tr>
<th><strong>Order no.</strong></th>
<th><strong>215-2BE06</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum OB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Total number DBs, FBs, FCs</td>
<td>-</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FBs</td>
<td>0 ... 1023</td>
</tr>
<tr>
<td>Number of FCs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FC size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FCs</td>
<td>0 ... 1023</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>1</td>
</tr>
</tbody>
</table>

### Time

| **Real-time clock buffered** | ✓ |
| **Clock buffered period (min.)** | 30 d |
| **Type of buffering** | Vanadium Rechargeable Lithium Battery |
| **Load time for 50% buffering period** | 20 h |
| **Load time for 100% buffering period** | 48 h |
| **Accuracy (max. deviation per day)** | 10 s |
| **Number of operating hours counter** | 8 |
| **Clock synchronization** | - |
| **Synchronization via MPI** | - |
| **Synchronization via Ethernet (NTP)** | - |

### Address areas (I/O)

| **Input I/O address area** | 1024 Byte |
| **Output I/O address area** | 1024 Byte |
| **Process image adjustable** | - |
| **Input process image preset** | 128 Byte |
| **Output process image preset** | 128 Byte |
| **Input process image maximal** | 128 Byte |
| **Output process image maximal** | 128 Byte |
| **Digital inputs** | 8192 |
| **Digital outputs** | 8192 |
| **Digital inputs central** | 512 |
| **Digital outputs central** | 512 |
| **Integrated digital inputs** | - |
| **Integrated digital outputs** | - |
### Order no.

<table>
<thead>
<tr>
<th>Function</th>
<th>215-2BE06</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog inputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
</tbody>
</table>

### Communication functions

<table>
<thead>
<tr>
<th>Function</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>4</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
</tbody>
</table>

### Functionality Sub-D interfaces

<table>
<thead>
<tr>
<th>Function</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>MP²I</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>-</td>
</tr>
<tr>
<td>MPI</td>
<td>✓</td>
</tr>
<tr>
<td>MP²I (MPI/RS232)</td>
<td>✓</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
<tr>
<td>5V DC Power supply provided</td>
<td>max. 90mA, non-isolated</td>
</tr>
<tr>
<td>24V DC Power supply provided</td>
<td>max. 100mA, non-isolated</td>
</tr>
</tbody>
</table>

### Functionality MPI

<table>
<thead>
<tr>
<th>Function</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Routing</td>
<td>-</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>Order no.</td>
<td>215-2BE06</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td><strong>S7 communication as client</strong></td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>19.2 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>187.5 kbit/s</td>
</tr>
<tr>
<td><strong>Functionality RJ45 interfaces</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>TP</td>
</tr>
<tr>
<td>Type of interface</td>
<td>Ethernet 10/100 MBit</td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>8</td>
</tr>
<tr>
<td>Productive connections</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Ethernet communication CP</strong></td>
<td></td>
</tr>
<tr>
<td>Number of productive connections, max.</td>
<td>16</td>
</tr>
<tr>
<td>Number of productive connections by Siemens NetPro, max.</td>
<td>16</td>
</tr>
<tr>
<td>S7 connections</td>
<td>-</td>
</tr>
<tr>
<td>User data per S7 connection, max.</td>
<td>-</td>
</tr>
<tr>
<td>TCP-connections</td>
<td>FETCH PASSIV, WRITE PASSIV, Connection of passive data handling</td>
</tr>
<tr>
<td>User data per TCP connection, max.</td>
<td>64 KB</td>
</tr>
<tr>
<td>ISO-connections</td>
<td>-</td>
</tr>
<tr>
<td>User data per ISO connection, max.</td>
<td>-</td>
</tr>
<tr>
<td>ISO on TCP connections (RFC 1006)</td>
<td>FETCH PASSIV, WRITE PASSIV, Connection of passive data handling</td>
</tr>
<tr>
<td>User data per ISO on TCP connection, max.</td>
<td>32 KB</td>
</tr>
<tr>
<td>UDP-connections</td>
<td>-</td>
</tr>
<tr>
<td>User data per UDP connection, max.</td>
<td>-</td>
</tr>
<tr>
<td>UDP-multicast-connections</td>
<td>-</td>
</tr>
<tr>
<td>UDP-broadcast-connections</td>
<td>-</td>
</tr>
<tr>
<td><strong>Datasizes</strong></td>
<td></td>
</tr>
<tr>
<td>Input bytes</td>
<td>0</td>
</tr>
<tr>
<td>Output bytes</td>
<td>0</td>
</tr>
<tr>
<td>Parameter bytes</td>
<td>3</td>
</tr>
<tr>
<td>Diagnostic bytes</td>
<td>0</td>
</tr>
<tr>
<td><strong>Housing</strong></td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>PPE / PA 6.6</td>
</tr>
<tr>
<td>Mounting</td>
<td>Profile rail 35 mm</td>
</tr>
<tr>
<td><strong>Order no.</strong></td>
<td>215-2BE06</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>Mechanical data</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions (WxHxD)</td>
<td>50.8 mm x 76 mm x 80 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>150 g</td>
</tr>
<tr>
<td><strong>Environmental conditions</strong></td>
<td></td>
</tr>
<tr>
<td>Operating temperature</td>
<td>0 °C to 60 °C</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-25 °C to 70 °C</td>
</tr>
<tr>
<td><strong>Certifications</strong></td>
<td></td>
</tr>
<tr>
<td>UL certification</td>
<td>yes</td>
</tr>
<tr>
<td>KC certification</td>
<td>-</td>
</tr>
</tbody>
</table>
4 Deployment

4.1 Assembly

Information about assembly and cabling: ‘Mounting’ on page 13

4.2 Start-up behavior

**Turn on power supply**

When the CPU is delivered it has been reset. After the power supply has been switched on, the CPU changes to the operating mode the operating mode lever shows. After a STOP → RUN transition the CPU switches to RUN without program.

**Boot procedure with valid data in the CPU**

The CPU switches to RUN with the program stored in the battery buffered RAM.

**Boot procedure with empty battery**

- The accumulator/battery is automatically loaded via the integrated power supply and guarantees a buffer for max. 30 days. If this time is exceeded, the battery may be totally discharged. This means that the battery buffered RAM is deleted.
- In this state, the CPU executes an overall reset because with an empty battery the RAM content is undefined. If a MMC with a S7PROG.WLD is plugged, program code and data blocks are transferred from the MMC into the work memory of the CPU.
- If there is no MMC, the project from the internal Flash is loaded.
- Depending on the position of the operating mode switch, the CPU remains in STOP respectively switches to RUN. Due to the battery error the CPU can only boot if there was an OB81 configured. Otherwise a manual restart (STOP/RUN) respectively PG command is necessary.
- On a start-up with an empty battery the SF LED is on and thus points to an entry in the diagnostic buffer.

Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity.

CAUTION!

After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset.
4.3 Addressing

Automatic addressing

To provide specific addressing of the installed peripheral modules, certain addresses must be allocated in the CPU. The CPU contains a peripheral area (addresses 0 ... 1023) and a process image of the inputs and the outputs (for both each address 0 ... 127). When the CPU is initialized it automatically assigns peripheral addresses to the digital input/output modules starting from 0. If there is no hardware projecting, analog modules are allocated to even addresses starting from address 128.

Signaling states in the process image

The signaling states of the lower addresses (0 ... 127) are additionally saved in a special memory area called the process image.

The process image is divided into two parts:
- process image of the inputs (PII)
- process image of the outputs (PIQ)

The process image is updated automatically when a cycle has been completed.

Read/write access

You may access the modules by means of read or write operations on the peripheral bytes or on the process image.

Please remember that you may access different modules by means of read and write operations on the same address.

The addressing ranges of digital and analog modules are different when they are addressed automatically.

- Digital modules: 0 ... 127
- Analog modules: 128 ... 1023
The following figure illustrates the automatic allocation of addresses:

You may change the allocated addresses at any time by means of the Siemens SIMATIC manager. In this way you may also change the addresses of analog modules to the range covered by the process image (0 ... 127) and address digital modules above 127. The following pages describe the required preparations and the procedure for this type of configuration.

### 4.4 Hints for the deployment of the MPI interface

#### What is MP²I?

The MP²I jack combines 2 interfaces in 1:
- MP Interface
- RS232 Interface

Please regard that the RS232 functionality is only available by using the Green Cable from VIPA.

#### Deployment as MPI

The MPI provides the data transfer between CPUs and PCs. In a bus communication you may transfer program and data between the CPUs interconnected via MPI. Connecting a common MPI cable, the MPI jack supports the full MPI functionality.
CAUTION!
Important notes for the deployment of MPI cables!
Deploying MPI cables at the CPUs from VIPA, you have to make sure that Pin 1 is not connected. This may cause transfer problems and in some cases damage the CPU! Especially PROFIBUS cables from Siemens, like e.g. the 6XV1 830-1CH30, must not be deployed at MP²I jack. For damages caused by nonobservance of these notes and at improper deployment, VIPA does not take liability!

Deployment as RS232 interface only via "Green Cable"

For the serial data transfer from your PC, you normally need a MPI transducer. Fortunately you may also use the "Green Cable" from VIPA. You can order this under the order no. VIPA 950-0KB00.

The "Green Cable" supports a serial point-to-point connection for data transfer via the MP²I jack exclusively for VIPA CPUs.

4.5 Hardware configuration - CPU

Overview

For the project engineering of the CPU 215-2BE06 and the other System 200V modules connected to the same VIPA bus, the hardware configurator from Siemens is to be used. To address the directly plugged peripheral modules, you have to assign a special address in the CPU to every module. The address allocation and the parameterization of the modules takes place in the Siemens SIMATIC manager as a virtual PROFIBUS system. For the PROFIBUS interface is standardized software sided, the functionality is guaranteed by including a GSD-file into the Siemens SIMATIC manager. Transfer your project into the CPU via the MPI interface.

Requirements

The following conditions must be fulfilled for project engineering:

- The Siemens SIMATIC manager is installed at PC respectively PG
- The GSD files have been included in Siemens hardware configurator
- Serial connection to the CPU (e.g. MPI-Adapter)

The configuration of the CPU requires a thorough knowledge of the Siemens SIMATIC manager and the hardware configurator!
Including the GSD-file

1. Go to www.vipa.com > Service > Download > PROFIBUS GSD files and download the file System_100V_-_200V_Vxxx.zip.

2. Extract the file to your work directory. The vipa_21x.gsd (German) respectively vipa_21x.gse (English) can be found at the directory CPU21x.

3. Start the Siemens hardware configurator and close every project.

4. Go to Options > Install new GSD file.

5. Navigate to the directory CPU21x and choose the corresponding file vipa_21x.gsd (German) or vipa_21x.gse (English)

⇒ Now the modules of the VIPA System 200V are integrated in the hardware catalog at PROFIBUS-DP > Additional field devices > I/O > VIPA_System_200V.

Proceeding

To be compatible with the Siemens SIMATIC manager the following steps should be executed:

1. Start the hardware configurator from Siemens with a new project.

2. Insert a profile rail from the hardware catalog.

3. Place at slot 2 the following CPU from Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.)

4. For the System 200V create a new PROFIBUS subnet.

5. Attach the slave system "VIPA_CPU21x" to the subnet with PROFIBUS-Address 1

⇒ After installing the vipa_21x.gsd the slave system may be found at the hardware catalog at PROFIBUS DP > Additional field devices > IO > VIPA_System_200V.

6. Place always at the 1. slot the corresponding 215-2BE06, by taking it from the hardware catalog.
4.6 Hardware configuration - I/O modules

### Hardware configuration of the modules

After the hardware configuration of the CPU place the System 200V modules in the plugged sequence. In order to address the installed peripheral modules individually, specific addresses in the CPU have to be assigned to them.

For parameterization double-click during the project engineering at the slot overview on the module you want to parameterize. In the appearing dialog window you may set the wanted parameters.

By using the SFCs 55, 56 and 57 you may alter and transfer parameters for wanted modules during runtime. For this you have to store the module specific parameters in so called "record sets". More detailed information about the structure of the record sets is to find in the according module description.

4.7 Hardware configuration - Ethernet PG/OP channel

### Overview

The CPU has an integrated Ethernet PG/OP channel. This channel allows you to program and remote control your CPU. With the first start-up respectively after an overall reset the Ethernet PG/OP channel does not have any IP address. For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this by means of the Siemens SIMATIC manager. This is called "initialization".

### Assembly and commissioning

1. Install your System 200V with your CPU.
2. Wire the system by connecting cables for voltage supply and signals.
3. Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet.

4. Switch on the power supply.
   ⇒ After a short boot time the CP is ready for communication. He possibly has no IP address data and requires an initialization.

"Initialization" via PLC functions

The initialization via PLC functions takes place with the following proceeding:

⇒ Determine the current Ethernet (MAC) address of your Ethernet PG/OP channel.
   ⇒ This always may be found at a sticker on the left side of the CPU.

Assign IP address parameters

You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens SIMATIC manager starting with version V 5.3 & SP3 with the following proceeding:

1. Start the Siemens SIMATIC manager and set via Options > Set PG/PC interface the access path to "TCP/IP -> Network card .... ".

2. Open with PLC > Edit Ethernet Node the dialog window with the same name.

3. To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The Mac address may be found at the 1. label beneath the front flap of the CPU.

4. Choose if necessary the known MAC address of the list of found stations.
5. Either type in the IP configuration like IP address, subnet mask and gateway. Or your station is automatically provided with IP parameters by means of a DHCP server. Depending on the chosen option the DHCP server is to be supplied with MAC address, equipment name or client ID. The client ID is a numerical order of max. 63 characters. The following characters are allowed: "hyphen", 0-9, a-z, A-Z

6. Confirm with [Assign IP configuration].

Direct after the assignment the Ethernet PG/OP channel may be reached online by these address data. The value remains as long as it is reassigned, it is overwritten by a hardware configuration or an factory reset is executed.

Take IP address parameters in project

1. Open the Siemens hardware configurator and configure the VIPA CPU 215-2BE06 as Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.) which is to be found at SIMATIC 300 \ CPU 300 \ CPU 315-2DP. If needed, parameterize the CPU 315-2DP.

2. Configure in deputy of your CP the CP 343-1 (343-1EX11) from Siemens at slot 4, to be found at SIMATIC 300 / CP 300 / Industrial Ethernet / CP 343-1.

3. Open the property window via double-click on the CP 343-1EX11 and enter for the CP at "Properties" the IP address data, which you have assigned before.

4. Transfer your project.

4.8 Setting CPU parameters

Parameterization via Siemens CPU

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.) in the Siemens hardware configurator, the parameters of the VIPA CPU may be set with "Object properties" of the CPU 315-2DP during hardware configuration. Via a double-click on the CPU 315-2DP the parameter window of the CPU may be accessed. Using the registers you get access to every standard parameter of the CPU.
4.8.1 Parameter CPU

The CPU does not evaluate each parameter, which may be set at the hardware configuration. The following parameters are supported by the CPU at this time:

**Supported parameters**

**General**
- Short description: Short description Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6).
- Order No. / Firmware: Order number and firmware are identical to the details in the "hardware catalog" window.
- Name: The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC Manager.
- Plant designation: Here is the possibility to specify a plant designation for the CPU. This plant designation identifies parts of the plant according to their function. Its structure is hierarchic according to IEC 1346-1.
- Comment: In this field information about the module may be entered.

**Startup**
- Startup when expected/actual configuration differs: If the checkbox for 'Startup when expected/actual configuration differs' is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU does not switch to RUN mode and remains in STOP mode. If the checkbox for 'Startup when expected/actual configuration differs' is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.
- Monitoring time for ready message by modules [100ms]: This operation specifies the maximum time for the ready message of every configured module after PowerON. Here connected PROFIBUS DP slaves are also considered until they are parameterized. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration. Monitoring time for ready message by modules [100ms]
- Transfer of parameters to modules [100ms]: The maximum time for the transfer of parameters to parametrizable modules. If not every module has been assigned parameters by the time this monitoring time has expired; the actual configuration becomes unequal to the preset configuration.
Cycle/Clock memory

- Update OB1 process image cyclically: This parameter is not relevant.
- Scan cycle monitoring time: Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:
  - Communication processes
  - a series of interrupt events
  - an error in the CPU program
- Minimum scan cycle time: This parameter is not relevant.
- Scan cycle load from Communication: This parameter is not relevant.
- Size of the process image input/output area: Here the size of the process image max. 2048 for the input/output periphery may be fixed.
- OB85 call up at I/O access error: The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system. The VIPA CPU is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.
- Clock memory: Activate the check box if you want to use clock memory and enter the number of the memory byte.

The selected memory byte cannot be used for temporary data storage.

Retentive Memory

- Number of Memory bytes from MB0: Enter the number of retentive memory bytes from memory byte 0 onwards.
- Number of S7 Timers from T0: Enter the number of retentive S7 timers from T0 onwards. Each S7 timer occupies 2 bytes.
- Number of S7 Counters from C0: Enter the number of retentive S7 counter from C0 onwards.
- Areas: This parameter is not supported.

Interrupts

- Priority: Here the priorities are displayed, according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts).

Time-of-day interrupts

- Priority: Here the priorities may be specified according to which the time-of-day interrupt is processed. With priority "0" the corresponding OB is deactivated.
- Active: Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.
- Execution: Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for start date and time.
- Start date/time: Enter date and time of the first execution of the time-of-day interrupt.
- Process image partition: This parameter is not supported.
Cyclic interrupts
- Priority: Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority "0" the corresponding interrupt is deactivated.
- Execution: Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.
- Phase offset: Enter the delay time in ms for current execution for the watch dog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.
- Process image partition: This parameter is not supported.

Protection
- Level of protection: Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.
  - Protection level 1 (default setting): No password adjustable, no restrictions
  - Protection level 2 with password: Authorized users: read and write access Unauthorized user: read access only
  - Protection level 3: Authorized users: read and write access Unauthorized user: no read and write access

4.9 Project transfer
Overview
There are the following possibilities for project transfer into the CPU:
- Transfer via MPI
- Transfer via Ethernet
- Transfer via MMC when using a MMC programmer

4.9.1 Transfer via MPI
The structure of a MPI net is electrically identical with the structure of a PROFIBUS net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and PROFIBUS cables. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI address 2.

MPI programming cable
The MPI programming cables are available at VIPA in different variants. The cables provide a RS232 res. USB plug for the PC and a bus enabled RS485 plug for the CPU. Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

Terminating resistor
A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment. Please make sure that the participants with the activated terminating resistors are always power supplied. Otherwise it may cause interferences on the bus.
Transfer with MPI programming cable (MPI communication)

Transfer via "Green Cable" (serial communication)

Via exclusively direct plugging of the "Green Cable" to a MP$^{2}I$ jack you may establish a serial connection between PC and CPU. Set the PC-COM port and the transfer rate 38400Baud at Local port. The settings of the register MPI are ignored at employment of the "Green Cable".

**MPI-Programmierkabel**
Currently the VIPA programming cables (950-0KBxx) are not supported for transfer via MPI. This is only possible with the programming cable from Siemens. Under Windows® 7 the "Green Cable" (950-0KB00) is not usable.

Configure MPI

Hints for configuring a MPI interface are to find in the documentation of your programming software. The "Green Cable" has the order number: 950-0KB00.

**WARNING!**
Please regard, that you may use the "Green Cable" exclusively at VIPA CPUs with MP$^{2}I$-interface! Please regard the hints for deploying the Green Cable and the MP$^{2}I$ jack!

Approach transfer via MPI interface

1. Connect your PC to the MPI jack of your CPU via a MPI programming cable.
2. Load your project in the SIMATIC manager from Siemens.
3. Choose in the menu **Options > Set PG/PC interface**
4. Select in the according list the "PC Adapter (MPI)"); if appropriate you have to add it first, then click on [Properties].
5. Set in the register **MPI** the transfer parameters of your MPI net and type a valid address.
6. Switch to the register *Local connection*.
7. Set the COM port of the PC and the transfer rate 38400Baud for the MPI programming cable from VIPA.
8. Via PLC > *Load to module* you may transfer your project via MPI to the CPU and save it on a MMC via PLC > *Copy RAM to ROM* if one is plugged.

*Please make sure to adjust the transfer rate to 38400Baud when using the "Green Cable" from VIPA.*

**Hints for the Green Cable**

The Green Cable is a green connection cable, manufactured exclusively for the deployment at VIPA System components. The Green Cable is a programming and download cable for VIPA CPUs MP2I jack and VIPA field bus masters. The Green Cable from VIPA is available under the order no. VIPA 950-0KB00.

The Green Cable allows you to:

- **transfer projects serial**
  - Avoiding high hardware needs (MPI transducer, etc.) you may realize a serial point-to-point connection via the Green Cable and the MP2I jack. This allows you to connect components to your VIPA-CPU that are able to communicate serial via a MPI adapter like e.g. a visualization system.

- **execute firmware updates of the CPUs and field bus masters**
  - Via the Green Cable and an upload application you may update the firmware of all recent VIPA CPUs with MP2I jack and certain field bus masters (see Note).

**Important notes for the deployment of the Green Cable**

Nonobservance of the following notes may cause damages on system components. For damages caused by nonobservance of the following notes and at improper deployment, VIPA does not take liability!

**Note to the application area**

The Green Cable may exclusively deployed directly at the concerning jacks of the VIPA components (in between plugs are not permitted). E.g. a MPI cable has to be disconnected if you want to connect a Green Cable. At this time, the following components support Green Cable: VIPA CPUs with MP2I jack and field bus masters from VIPA.

**Note to the lengthening**

The lengthening of the Green Cable with another Green Cable res. The combination with further MPI cables is not permitted and causes damages of the connected components! The Green Cable may only be lengthened with a 1:1 cable (all 9 pins are connected 1:1).
4.9.2 Transfer via Ethernet

For transfer via Ethernet the CPU has the following interface:

- Ethernet PG/OP channel

Initialization

So that you may access the Ethernet PG/OP channel you have to assign IP address parameters by means of the "initialization".

*Hardware configuration - Ethernet PG/OP channel on page 41*

Transfer

1. For the transfer, connect, if not already done, the appropriate Ethernet port to your Ethernet.
2. Open your project with the Siemens SIMATIC manager.
3. Set via Options > Set PG/PC Interface the access path to "TCP/IP -> Network card .... ".
4. Click to PLC > Download
   
   \(\rightarrow\) the dialog "Select target module" is opened.

   Select your target module and enter the IP address parameters of the Ethernet PG/OP channel for connection. Provided that no new hardware configuration is transferred to the CPU, the entered Ethernet connection is permanently stored in the project as transfer channel.
5. With [OK] the transfer is started.

* System dependent you get a message that the projected system differs from target system. This message may be accepted by [OK].

   \(\rightarrow\) Your project is transferred and may be executed in the CPU after transfer.

4.9.3 Transfer via MMC

The MMC (Memory Card) serves as external transfer and storage medium. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project is stored in the root directory and has one of the following file names:

- S7PROG.WLD
- S7PROGF.WLD
- AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC manager a new wld file may be created. After the creation copy the blocks from the project blocks folder and the System data into the wld file.

Transfer MMC \(\rightarrow\) CPU

The transfer of the application program from the MMC into the CPU takes place depending on the file name after an overall reset or PowerON.
S7PROG.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM.

S7PROGF.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM and additionally into the Flash memory. An access to the Flash memory only takes place at empty battery of the buffer and when no MMC with user program is plugged-in.

AUTOLOAD.WLD is read after PowerON from the MMC and transferred into the battery-buffered RAM.

During the transfer the "MC" LED blinks. Please regard that your user memory serves for enough space, otherwise your user program is not completely loaded and the SF LED gets on. Execute a compression before the transfer, for this does not happen automatically.

**Transfer CPU → MMC**

When the MMC has been installed, the write command stores the content of the battery buffered RAM as *S7PROG.WLD* on the MMC and in the internal Flash memory. The write command is controlled by means of the block area of the Siemens SIMATIC manager **PLC > Copy RAM to ROM**. During the write process the "MC"-LED of the CPU is blinking. When the LED expires the write process is finished. If this project is to be loaded automatically from the MMC with PowerON, you have to rename this on the MMC to *AUTOLOAD.WLD*.

**Transfer control**

After a MMC access, an ID is written into the diagnostic buffer of the CPU. To monitor the diagnosis entries, you select **PLC > Module Information** in the Siemens SIMATIC manager. Via the register "Diagnosis Buffer" you reach the diagnosis window. Information about the Event-IDs can be found at "VIPA specific diagnostic entries".

### 4.10 Operating modes

**Overview**

The CPU can be in one of 3 operating modes:

- Operating mode STOP
- Operating mode START-UP
- Operating mode RUN

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

**Operating mode STOP**

- The application program is not processed.
- If there has been a processing before, the values of counters, timers, flags and the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RUN-LED (R) off
- STOP-LED (S) on
During the transition from STOP to RUN the system calls the start-up organization block OB 100. The processing time for this OB is not monitored. The start-up OB may issue calls to other blocks.

- All digital outputs are disabled during the start-up, i.e. outputs are inhibited.
- RUN-LED blinks as soon as the OB 100 is operated and for at least 3s, even if the start-up time is shorter or the CPU gets to STOP due to an error. This indicates the start-up.
- STOP-LED off

When the CPU has completed the start-up OB, it assumes the operating mode RUN.

The application program in OB 1 is processed in a cycle. Under the control of alarms other program sections can be included in the cycle.

- All timers and counters being started by the program are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RUN-LED on
- STOP-LED off

The CPUs include security mechanisms like a Watchdog (100ms) and a parameterizable cycle time surveillance (parameterizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state. The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN → STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>Voltage outputs issue 0V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current outputs 0...20mA issue 0mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current outputs 4...20mA issue 4mA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If configured also substitute values may be issued.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>decentral outputs</td>
<td>Same behavior as the central digital/analog outputs.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP → RUN res. PowerON</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIO → Read PII → OB 1.</td>
</tr>
</tbody>
</table>
### Overall reset

#### Overview

During the overall reset the entire user memory is erased. Data located in the memory card is not affected.

You have 2 options to initiate an overall reset:

- initiate the overall reset by means of the function selector switch
- initiate the overall reset by means of the configuration software
  
  e.g. Siemens SIMATIC manager

You should always issue an overall reset to your CPU before loading an application program into your CPU to ensure that all blocks have been cleared from the CPU.

#### Overall reset by means of the function selector

**Condition**

The operating mode of the CPU is STOP. Place the function selector on the CPU in position "ST"

⇒ the S-LED is on.

**Overall reset**

1. Place the function selector in the position MR and hold it in this position for app. 3 seconds.
   
   ⇒ The S-LED changes from blinking to permanently on.

2. Place the function selector in the position ST and switch it to MR and quickly back to ST within a period of less than 3 seconds.
   
   ⇒ The S-LED blinks (overall reset procedure).

---

### Deployment

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are once be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>RUN</td>
<td>general</td>
<td>The program execution happens cyclically and can therefore be foreseen: Read PII (\rightarrow) OB 1 (\rightarrow) Write PIO.</td>
</tr>
</tbody>
</table>

PII: Process image inputs, PIO: Process image outputs
3. The overall reset has been completed when the S-LED is on permanently.
   ⇒ The S-LED is on.

The following figure illustrates the above procedure:

![Diagram of LED states during reset]

Automatic reload

1. If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC.
   ⇒ The MC LED is on.

2. When the reload has been completed the LED is extinguished. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.

Overall reset by means of the Siemens SIMATIC manager

Condition
The operating mode of the CPU must be STOP. You may place the CPU in STOP mode by the menu command PLC > Operating mode.

Overall reset
1. You may request the overall reset by means of the menu command PLC > Clean/Reset.

2. In the dialog window you may place your CPU in STOP mode and start the overall reset if this has not been done as yet. The S-LED blinks during the overall reset procedure.
   ⇒ When the S-LED is on permanently the overall reset procedure has been completed.

Automatic reload

1. If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC.
   ⇒ The MC LED is on.

2. When the reload has been completed the LED is extinguished. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.
Reset to factory setting

A *Factory reset* deletes the internal RAM of the CPU completely and sets it back to the delivery state. Please regard that the MPI address is also set back to default 2! More information may be found at the part "Factory reset" further below.

4.12 Firmware update

**Overview**

There is the opportunity to execute a firmware update for the CPU 215-2BE06 and its components via MMC. For this an accordingly prepared MMC must be in the CPU during the startup. So a firmware files can be recognized and assigned with startup, a file name is reserved for each updatable component (see table below). After PowerON and CPU STOP the CPU checks if there is a firmware file on the MMC. If this firmware version is different to the existing firmware version, this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

**Latest Firmware at www.vipa.com**

The latest firmware versions are to be found in the service area at www.vipa.com

**Find out CPU firmware version**

A label on the rear of the module indicates the firmware version. You may display the current firmware version of your CPU via the Siemens SIMATRIC manager. To display the firmware version, you go online with the CPU via your PG or PC and start the Siemens SIMATRIC manager. Via **PLC > Module status**, register "General", the current firmware version is evaluated and displayed.

**Load firmware and transfer it to MMC with reserved file name**

- Go to www.vipa.com
- Click on Service > Download > Firmware.
- Navigate to via System 200V > CPU to your CPU and download according to your hardware version the zip file to your PC.
- Open the zip file and copy the files to your MMC.
- Rename this accordingly

**Reserved file names**

By means of a reserved file name in the CPU 215-2BE06 you may transfer a firmware per MMC:

<table>
<thead>
<tr>
<th>Component</th>
<th>File name order no._release_version.ZIP</th>
<th>New file name at MMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Bx000... .bin</td>
<td>firmware.bin</td>
</tr>
<tr>
<td>CP</td>
<td>px000245.pkg</td>
<td>px000245.pkg</td>
</tr>
</tbody>
</table>
WARNING!
When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA-Hotline! Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Transfer firmware from MMC into CPU

1. Switch the operating mode switch of your CPU in position ST. Turn off the voltage supply. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC shows that at least a differing firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating mode switch lever downwards to MR within 10s and leave it in ST position.

4. During the update process, the LEDs SF and FC are alternately blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, S, SF, FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FC flash after a short start-up period. Continue with point 3.

If the LEDs do not flash, the firmware update is ready.

⇒ Now a factory reset should be executed (see next page). After that the CPU is ready for duty.

Now a factory reset should be executed (see next page). After that the CPU is ready for duty.
4.13 Factory reset

**Proceeding**

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state. Please note that here also the MPI address is reset to the address 2!

1. Switch the CPU to STOP.
2. Push the operating mode switch down to position MR for 30s. Here the S LED flashes. After a few seconds the stop LED changes to static light. Now the S LED changes between static light and flashing. Starting here count the static light states of the S LED.
3. After the 6. static light release the operating mode switch and tip it downwards to MR. Now the R LED lights up once. This means that the RAM was deleted completely.
4. For the confirmation of the resetting procedure the LEDs PW and S are on.
5. Then you have to switch the power supply off and on.

⇒ The proceeding is shown in the following Illustration:

![Illustration showing the steps of factory reset](image)

4.14 Diagnostic entries

**Entries in the diagnostic buffer**

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC Manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored at the memory card by means of the CMD DIAGBUF.

![Information icon] After the firmware update you always should execute a Factory reset.

![Information icon] Every register of the module information is supported by the VIPA CPUs. More information may be found at the online help of the Siemens SIMATIC Manager.
To monitor the diagnostic entries you choose the option ‘PLC Module Information’ in the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you reach the diagnostic window:

The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU. The following page shows an overview of the VIPA specific Event-IDs.

### Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xE003   | Error at access to I/O devices  
Zinfo1: I/O address  
Zinfo2: Slot |
| 0xE004   | Multiple parameterization of a I/O address  
Zinfo1: I/O address  
Zinfo2: Slot |
| 0xE005   | Internal error -Please contact the VIPA-Hotline! |
| 0xE006   | Internal error -Please contact the VIPA-Hotline! |
| 0xE007   | Configured in-/output bytes do not fit into I/O area |
| 0xE008   | Internal error -Please contact the VIPA-Hotline! |
| 0xE009   | Error at access to standard back plane bus |
| 0xE010   | Not defined module group at backplane bus recognized  
Zinfo2: Slot  
Zinfo3: Type ID |
| 0xE011   | Master project engineering at Slave-CPU not possible  
or wrong slave configuration |
| 0xE012   | Error at parameterization |
| 0xE013   | Error at shift register access to VBUS digital modules |
### Event-ID  Description

0xE014  Error at Check_Sys

0xE015  Error at access to the master  
Zinfo2: Slot of the master (32=page frame master)

0xE016  Maximum block size at master transfer exceeded  
Zinfo1: I/O address  
Zinfo2: Slot

0xE017  Error at access to integrated slave

0xE018  Error at mapping of the master I/O devices

0xE019  Error at standard back plane bus system recognition

0xE01A  Error at recognition of the operating mode (8 / 9 Bit)

0xE0CC  Communication error MPI / Serial

0xE100  MMC access error

0xE101  MMC error file system

0xE102  MMC error FAT

0xE104  MMC error at saving

0xE200  MMC writing finished (Copy Ram to Rom)

0xE210  MMC reading finished (reload after overall reset)

0xE300  Internal Flash writing ready (Copy RAM to ROM)

0xE310  Internal Flash reading finished (reload after battery failure)

---

### 4.15 Using test functions for control and monitoring of variables

#### Overview

For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item **Debug** of the Siemens SIMATIC Manager.

- The status of the operands and the RLO can be displayed by means of the test function **'Debug ➔ Monitor'**.
- The status of the operands and the RLO can be displayed by means of the test function **'PLC ➔ Monitor/Modify Variables'**.

#### 'Debug ➔ Monitor'

This test function displays the current status and the RLO of the different operands while the program is being executed. It is also possible to enter corrections to the program.

*When using the test function "Monitor" the PLC must be in RUN mode!*
The processing of the states may be interrupted by means of jump commands or by timer and process-related interrupts. The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer valid. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0. For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation RLO
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a “?“.

This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program execution. This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

- Control of outputs
  - It is possible to check the wiring and proper operation of output modules.
  - You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

- Control of variables
  - The following variables may be modified: I, Q, M, T, C and D.
  - The process image of binary and digital operands is modified independently of the operating mode of the CPU.
  - When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.
  - Process variables are controlled asynchronously to the execution sequence of the program.
5 Configuration with TIA Portal

5.1 TIA Portal - Limitations

**General**

Since the VIPA-CPU is configured as CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.) in the Siemens TIA Portal, there are limitations with the configuration of the VIPA-CPU, which are in the following described.

**VIPA specific SFCs**

The VIPA specific SFCs are not supported during programming with the Siemens TIA Portal.

**Operating blocks - OBs**

- OB 55 "Status interrupt" is not supported by the VIPA-CPU
- OB 56 "Update interrupt" is not supported by the VIPA-CPU
- OB 81 "Error in power supply" exists in the VIPA-CPU but is not supported by the Siemens TIA Portal
- The phase shift, available for the OB 35 "Watchdog" in the Siemens TIA Portal, is not evaluated by the VIPA-CPU.

**Further limitations**

- "Plant designation" and "location identifier" in the Siemens TIA Portal are not supported by the VIPA-CPU.
- In contrast to the Siemens CPU 315-2DP with a periphery address area 0 ... 2047, the periphery address area of the VIPA-CPU is limited to 0 ... 1023. The diagnostic address area is 0 ... 2047 and is not limited.
- The bit memory (retentive memory) area is limited to 0 ... 1023.

5.2 TIA Portal - Work environment

5.2.1 General

In this chapter the project engineering of the VIPA CPU in the Siemens TIA Portal is shown. Here only the basic usage of the Siemens TIA Portal together with a VIPA CPU is shown. Please note that software changes can not always be considered and it may thus be deviations to the description. TIA means Totally Integrated Automation from Siemens. Here your VIPA PLCs may be configured and linked. For diagnostics online tools are available.

Information about the Siemens TIA Portal can be found in the online help respectively in the according online documentation.

**Starting the TIA Portal**

To start the Siemens TIA Portal with Windows select ‘Start \ Programs \ Siemens Automation \ TIA …’

Then the TIA Portal opens with the last settings used.
Exiting the TIA Portal

With the menu ‘Project ➔ Exit’ in the ‘Project view’ you may exit the TIA Portal. Here there is the possibility to save changes of your project before.

5.2.2 Work environment of the TIA Portal

Basically, the TIA Portal has the following 2 views. With the button on the left below you can switch between these views:

Portal view

The ‘Portal view’ provides a "task oriented" view of the tools for processing your project. Here you have direct access to the tools for a task. If necessary, a change to the Project view takes place automatically for the selected task.

Project view

The ‘Project view’ is a "structured" view to all constituent parts of your project.

Areas of the Project view

The Project view is divided into the following areas:
5.3 TIA Portal - Hardware configuration - CPU

General

The hardware configuration of the CPU and the system 200V modules at the VIPA bus takes place in the Siemens TIA Portal as a virtual PROFIBUS systems. For the PROFIBUS interface is standardized software sided, the functionality is guaranteed by including a GSD-file into the Siemens TIA Portal. Your project can be transferred to the CPU via MPI interface or by means of a MMC.

Including the GSD-file

1. Go to www.vipa.com > Service > Download > PROFIBUS GSD files and download the file System_100V_-_200V_Vxxx.zip.
2. Extract the file to your work directory. The vipa_21x.gsd (German) respectively vipa_21x.gse (English) can be found at the directory CPU21x.
3. Start the Siemens hardware configurator and close every project.
4. Go to Options > Install new GSD file.
5. Navigate to the directory CPU21x and choose the corresponding file vipa_21x.gsd (German) or vipa_21x.gse (English)

⇒ Now the modules of the VIPA System 200V are integrated in the hardware catalog at PROFIBUS-DP \ Additional field devices \ I/O \ VIPA_System_200V.
With the Siemens TIA Portal the CPU from VIPA is to be configured as CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.) from Siemens.

1. Start the Siemens TIA Portal.
2. Create a new project in the Portal view with ‘Create new project’.
3. Switch to the Project view.
4. Click in the Project tree at ‘Add new device’.
5. Select the following CPU in the input dialog:
   SIMATIC S7-300 > CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.)
   ⇒ The CPU is inserted with a profile rail.

### Device overview:

<table>
<thead>
<tr>
<th>Module</th>
<th>...</th>
<th>Slot</th>
<th>...</th>
<th>Type</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC ...</td>
<td>2</td>
<td></td>
<td></td>
<td>CPU 315-2DP</td>
<td></td>
</tr>
<tr>
<td>MPI interface</td>
<td>2 0</td>
<td></td>
<td></td>
<td>MPI interface</td>
<td></td>
</tr>
<tr>
<td>DP interface</td>
<td>2 X2</td>
<td></td>
<td></td>
<td>DP interface</td>
<td></td>
</tr>
</tbody>
</table>

### Setting standard CPU parameters

Since the CPU from VIPA is configured as Siemens CPU, so the setting of the parameters takes place via the Siemens CPU. For parametrization click in the Project area respectively in the Device overview at the CPU part. Then the parameters of the CPU part are shown in the Properties dialog. Here you can make your parameter settings. § ‘Parameter CPU’ on page 44

### 5.3.1 Virtual PROFIBUS master system

Configure a PROFIBUS master system

Connect and parameterize the internal DP interface at operation mode "DP-Master".
1. Switch in the Project area to "Network view".

2. Connect the slave system "VIPA_CPU 21x". After installing the vipa_21x.GSD this may be found in the hardware catalog at:
   Other field devices > PROFIBUS DP > I/O > VIPA GmbH > VIPA_System_200V > VIPA_CPU21x.

3. For the slave system CPU21x-Slave-System set the PROFIBUS address 1.

---

Thus, the VIPA components can be displayed, you have to deactivate the "Filter" of the hardware catalog.

1. Click at the slave system and open the "Device overview" in the Project area.

2. Configure at slot 1 the according CPU 215-2BE06 of the hardware catalog of the VIPA_System_200V.

### Device overview:

<table>
<thead>
<tr>
<th>Module</th>
<th>Slot</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave ...</td>
<td>0</td>
<td>VIPA CPU21x</td>
</tr>
<tr>
<td>215-2BE06</td>
<td>1</td>
<td>215-2BE06</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

### Configuration of the DP slaves

1. Install the corresponding GSD file of your slave system in the hardware configurator.

2. Search the corresponding PROFIBUS DP slave in the hardware catalog and drag&drop it to the subnet of your master.

3. Assign a valid PROFIBUS address > 2 to the DP slave.
4. Add your modules according to the real hardware assembly.

5.4 TIA Portal - Hardware configuration - I/O modules

**Hardware configuration of the modules**

After the hardware configuration of the CPU place the System 300 modules at the bus in the plugged sequence. For this drag&drop the according module from the Hardware catalog to the according position of the profile rail in the *Project area* or in the *Device overview*.

### Device overview

<table>
<thead>
<tr>
<th>Module</th>
<th>...</th>
<th>Slot</th>
<th>...</th>
<th>Type</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC...</td>
<td></td>
<td>1</td>
<td></td>
<td>CPU...</td>
<td></td>
</tr>
<tr>
<td>DI...</td>
<td></td>
<td>2</td>
<td></td>
<td>DI...</td>
<td></td>
</tr>
<tr>
<td>DO...</td>
<td></td>
<td>3</td>
<td></td>
<td>DO...</td>
<td></td>
</tr>
<tr>
<td>DIO...</td>
<td></td>
<td>4</td>
<td></td>
<td>DIO...</td>
<td></td>
</tr>
<tr>
<td>AI...</td>
<td></td>
<td>5</td>
<td></td>
<td>AI...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parametrization

For parametrization click in the Project area respectively in the Device overview on the module you want to parameterize. The parameters of the module appear in the Properties dialog. Here you can make your parameter settings.

5.5 TIA Portal - Hardware configuration - Ethernet PG/OP channel

Overview

The CPU has an integrated Ethernet PG/OP channel. This channel allows you to program and remote control your CPU.

- The Ethernet PG/OP channel also gives you access to the internal web page that contains information about firmware version, connected I/O devices, current cycle times etc.
- At the first commissioning respectively after a factory reset the Ethernet PG/OP channel has no IP address.
- For online access to the CPU via the Ethernet PG/OP channel, valid IP address parameters have to be assigned to this. This is called "initialization".
- This can be done with the Siemens TIA Portal.

Assembly and commissioning

1. Install your System 300S with your CPU.
2. Wire the system by connecting cables for voltage supply and signals.
3. Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet.
4. Switch on the power supply.
   - After a short boot time the CP is ready for communication. He possibly has no IP address data and requires an initialization.

"Initialization" via Online functions

The initialization via the Online functions takes place with the following proceeding:

Determine the current Ethernet (MAC) address of your Ethernet PG/OP channel. This can be found as 1. address under the front flap of the CPU on a sticker on the left side.

Assign IP address parameters

You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens TIA Portal with the following proceeding:

1. Start the Siemens TIA Portal.
2. Switch to the ‘Project view’.
3. Click in the ‘Project tree’ at ‘Online access’ and choose here by a doubleclick your network card, which is connected to the Ethernet PG/OP channel.
4. To get the stations and their MAC address, use the ‘Accessible device’. The MAC address can be found at the 1. label beneath the front flap of the CPU.

5. Choose from the list the module with the known MAC address (Onboard PG/OP [MAC address]) and open with "Online & Diagnostics" the diagnostics dialog in the Project area.

6. Navigate to Functions > Assign IP address. Type in the IP configuration like IP address, subnet mask and gateway.

7. Confirm with [Assign IP configuration].

⇒ Directly after the assignment the Ethernet PG/OP channel is online reachable using the set IP address data. The value remains as long as it is reassigned, it is overwritten by a hardware configuration or an factory reset is executed.

---

**Take IP address parameters in project**

1. Open your project.

2. If not already done, configure in the ‘Device configuration’ a Siemens CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6.).

3. Configure the System 200V modules.

4. For the Ethernet PG/OP channel you have to configure a Siemens CP 343-1 (6GK7 343-1EX11 0XE0) always as last module after the really plugged modules.

5. Open the "Property" dialog by clicking on the CP 343-1EX11 and enter for the CP at "Properties" at "Ethernet address" the IP address data, which you have assigned before.

6. Transfer your project.
Device overview:

<table>
<thead>
<tr>
<th>Module</th>
<th>Slot</th>
<th>Type</th>
</tr>
</thead>
</table>
| PLC...  | 1    | CPU ...
|         |      |      |
| DI...   | 2    | DI...
| DO...   | 3    | DO...
| DIO...  | 4    | DIO...
| AI...   | 5    | AI...
| AO...   | 6    | AO...
| CP 343-1| 7    | CP 343-1 |

5.6 TIA Portal - Project transfer

Overview

There are the following possibilities for project transfer into the CPU:

- Transfer via MPI
- Transfer via Ethernet
- Transfer via memory card

Transfer via MPI

Currently the VIPA programming cables for transfer via MPI are not supported. This is only possible with the programming cable from Siemens.

1. Establish a connection to the CPU via MPI with an appropriate programming cable. Information may be found in the corresponding documentation of the programming cable.

2. Switch-ON the power supply of your CPU and start the Siemens TIA Portal with your project.

3. Select in the Project tree your CPU and choose ‘Context menu ➔ Download to device ➔ Hardware configuration’ to transfer the hardware configuration.

4. To transfer the PLC program choose ‘Context menu ➔ Download to device ➔ Software’. Due to the system you have to transfer hardware configuration and PLC program separately.
Transfer via Ethernet

For transfer via Ethernet the CPU has the following interface:
- Ethernet PG/OP channel

Initialization

So that you may use the according Ethernet interface, you have to assign IP address parameters by means of the "initialization". Please consider to use the same IP address data in your project for the CP 343-1.

Transfer

1. For the transfer, connect, if not already done, the appropriate Ethernet jack to your Ethernet.
2. Open your project with the Siemens TIA Portal.
3. Click in the Project tree at Online access and choose here by a double-click your network card, which is connected to the Ethernet PG/OP interface.
4. Select in the Project tree your CPU and click at [Go online].
5. Set the access path by selecting "PN/IE" as type of interface, your network card and the according subnet. Then a net scan is established and the corresponding station is listed.
7. Click to ‘Online ➔ Download to device’.
   ▶ The according block is compiled and by a request transferred to the target device. Provided that no new hardware configuration is transferred to the CPU, the entered Ethernet connection is permanently stored in the project as transfer channel.

Transfer via memory card

The memory card serves as external storage medium. There may be stored several projects and sub-directories on a memory card. Please regard that your current project is stored in the root directory and has one of the following file names:
- S7PROG.WLD
- AUTOLOAD.WLD
1. Create in the Siemens TIA Portal a wld file with ‘Project ➔ Memory card file ➔ New’.
   ▶ The wld file is shown in the Project tree at "SIMATIC Card Reader" as "Memory card file".
2. Copy the blocks from the Program blocks to the wld file. Here the hardware configuration data are automatically copied to the wld file as "System data".

Transfer memory card ➔ CPU

The transfer of the application program from the memory card into the CPU takes place depending on the file name after an overall reset or PowerON.
- S7PROG.WLD is read from the memory card after overall reset.
- AUTOLOAD.WLD is read from the memory card after PowerON.

The blinking of the MC LED of the CPU marks the active transfer. Please regard that your user memory serves for enough space for your user program, otherwise your user program is not completely loaded and the SF LED gets on.
When a memory card has been installed, the write command stores the content of the RAM as S7PROG.WLD on the memory card. The write command can be found in the Siemens TIA Portal in the Task card "Online tools" in the command area at "Memory" as button [Copy RAM to ROM]. The MC LED blinks during the write access. When the LED expires, the write process is finished. If this project is to be loaded automatically from the memory card with PowerON, you have to rename this to on the memory card to AUTOLOAD.WLD.

Please note that in the Siemens TIA Portal with some CPU types the [Copy RAM to ROM] button is not available.

After accessing the memory card you can find a diagnostics entry in the CPU. To monitor the diagnostics entries, you select Online & Diagnostics in the Siemens TIA Portal. Here you can access the "Diagnostics buffer". See "Diagnostic entries' on page 56